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Using the vCenter Orchestrator Plug-In
for vCloud Director 5.5
Using the vCenter Orchestrator Plug-In for vCloud Director 5.5 provides information and instructions
®
®
about configuring and using the VMware vCenter Orchestrator plug-in for VMware vCloud Director 5.5.

Intended Audience
This information is intended for anyone who is installing and configuring the plug-in, and using the API of
the plug-in. Using the vCenter Orchestrator Plug-In for vCloud Director 5.5 is written for experienced
users who are familiar with virtual machine technology, with Orchestrator workflow development, and with
vCloud Director.
For more information about Orchestrator, see
http://www.vmware.com/support/pubs/orchestrator_pubs.html.
For more information about vCloud Director, see http://www.vmware.com/support/pubs/vcd_pubs.html.
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Introduction to the VMware
vCenter Orchestrator Plug-In for
vCloud Director

1

The vCloud Director plug-in (VMware vCenter Orchestrator plug-in for vCloud Director) allows interaction
between vCenter Orchestrator and vCloud Director.
You can use the plug-in to run Orchestrator workflows that automate vCloud Director processes. The
plug-in contains a set of standard workflows. You can also create custom workflows that implement the
plug-in API to automate tasks in your vCloud Director environment.
This section includes the following topics:
n
vCloud Director Plug-In Components
n

Installing and Configuring the vCloud Director Plug-In

vCloud Director Plug-In Components
The vCloud Director plug-in relies on a number of components to function properly.
vCenter Orchestrator and vCloud Director provide the platform for the plug-in, and the plug-in provides
interaction between those products.
Figure 1‑1. Component Relations
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The vCloud Director plug-in implements the User, Admin, and Admin Extensions API classes that
correspond to the types of API classes in vCloud Director. All users can read User API classes and users
with appropriate rights can modify these classes. Users with administrative rights can modify Admin API
and User API classes. The Admin Extensions API classes are VMware-specific and only system
administrators can modify these classes. System administrators can also modify Admin API and User API
classes.
The vCloud Java SDK provides the communication platform between the JavaScript API of the plug-in
and the vCloud Director REST API.

Role of vCenter Orchestrator with the vCloud Director Plug-In
You must use the Orchestrator configuration interface to install and configure the vCloud Director plug-in.
You use the Orchestrator client to run and create workflows and access the plug-in API.
The vCloud Director plug-in is powered by vCenter Orchestrator. Orchestrator is a development and
process-automation platform that provides a library of extensible workflows to manage the VMware
vCenter infrastructure and other technologies.
Orchestrator allows integration with management and administration solutions through its open plug-in
architecture. vCloud Director is one example of an administration solution that you can integrate with
Orchestrator by using plug-ins.

Plug-In Interaction with vCloud Director
You use the plug-in to run Orchestrator workflows that interact with vCloud Director to perform automated
tasks in the vCloud infrastructure.
With vCloud Director, you can build secure, multitenant clouds by combining virtual infrastructure
resources into virtual datacenters. The virtual datacenters are a fully automated, catalog-based service
that users access through Web-based portals and programmatic interfaces.

Installing and Configuring the vCloud Director Plug-In
You must use the Orchestrator configuration interface to install and configure the vCloud Director plug-in.

vCloud Director Plug-In Functional Prerequisites
To be able to install and use the vCloud Director plug-in, your system must meet the following product
prerequisites.

vCenter Orchestrator
Verify that you have a running instance of Orchestrator. You can log in to the Orchestrator configuration
interface at https://orchestrator_server:8283. Version 5.5 of the plug-in works with vCenter
Orchestrator 5.5.
For information about setting up Orchestrator, see the documentation about installing and configuring the
respective Orchestrator version.

VMware, Inc.
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vCloud Director
Verify that you have access to a vCloud Director instance. You can test your user credentials at
https://vcloud_director_server. Version 5.5 of the plug-in works with vCloud Director 5.5.
For information about setting up vCloud Director, see the vCloud Director Installation and Configuration
Guide.

Install the vCloud Director Plug-In
To be able to use the vCloud Director plug-in, you must download the .vmoapp file containing the plug-in
and install it using the Orchestrator configuration interface.
Prerequisites
n

n

Verify that you are logged in to the Orchestrator configuration interface at https://orchestrator_server:
8283.
Verify that you have downloaded the .vmoapp file from
http://www.vmware.com/products/datacenter-virtualization/vcenter-orchestrator/plugins.html.

Procedure

1

On the General tab, click Install Application.

2

Upload the vCloud Director plug-in.
a

Click the magnifying glass icon.

b

Select the .vmoapp file to install.

c

Click Open.

d

Click Install.

The vCloud Director plug-in tab appears in the Orchestrator configuration interface.
3

On the Startup Options tab, click Restart service to complete the plug-in installation.

Authentication Strategy
When you configure the vCloud Director plug-in, you must select an authentication method for managing
users when they log in to your vCloud Director instance.
Basic Authentication

The basic authentication method provides a way to log in with user name
and password.

SAML Authentication

The Security Assertion Markup Language (SAML) authentication method
provides a token log in. This token is shared between all instances used by
the user.
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If you decide to use Basic Authentication and Session per user methods, ensure that the Orchestrator
server is configured for LDAP authentication. The vCloud Director plug-in uses the user name and
password of the current user to log in to vCloud Director.
If you decide to use SAML Authentication and Session per user methods, ensure that the Orchestrator
server is configured for Single Sign On authentication. The plug-in uses the Single Sign On token
provided by the Orchestrator server to log in to vCloud Director.
The following figure shows the Session per user method to connect vCenter Orchestrator, vCloud Director
plug-in, LDAP server or Single Sign On Server, and vCloud Director, when using SAML or Basic
authentication.
Figure 1‑2. Session Per User Method
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vCloud Director
plug-in

LDAP

Log in

SAML Authentication

vCloud Director

SSO

If you decide to use Basic Authentication and Shared session methods, the Orchestrator server
authentication mode is ignored and the plug-in uses a predefined user name and password to log in to
vCloud Director.
If you decide to use SAML Authentication and Shared session methods, the Orchestrator server
authentication mode is ignored and the plug-in uses the SAML token provided by a callback action to log
in to vCloud Directorr. You must implement the callback action in your Orchestrator client.
Scripting example of the callback action
String acquireSamlToken() {
var tokenKey = "cd5727e0-b5fd-11e1-afa6-0800200c9a66";
var properties = new VclSharedProperties();
var token = properties.getProperty(tokenKey);
if (token == null) {
var tokenLifetime = 600000; // 10 min lifetime
token = // TODO: your logic to acquire the token
properties.putProperty(tokenKey, token, tokenLifetime);
}
return token;
}

The following figure shows the Shared session method to connect vCloud Director plug-in, LDAP server
or Single Sign On Server, and vCloud Director when using SAML or Basic authentication.
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Figure 1‑3. Shared Session Method
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Configure the vCloud Director Plug-In
To be able to manage vCloud Director instances by using the vCloud Director plug-in, you must configure
the connection parameters for each vCloud Director instance.
Prerequisites
n

Using the Network tab of the Orchestrator configuration interface, import the SSL certificate for the
vCloud Director instance that you want to connect.

n

Synchronize the time on the virtual machines on which the Orchestrator server, vCloud Director
server and Single Sign On server are installed. To synchronize the time, see Synchronize the Time by
Using the vSphere Web Client.

Procedure

1

Log in to the Orchestrator client and select Design or Run from the drop-down menu in the top left
corner.

2

Click the Workflows view in left pane of the Orchestrator client.

3

Expand the hierarchical list to Library > vCloud Director > Plug-in Configuration and navigate to
the Add a connection workflow.

4

Right-click the Add a connection workflow and select Start workflow.

5

In the Host text box, type the IP address or the DNS name of the vCloud Director instance.

6

In the Port text box, type the port number.
The default port is 443.

7

Select whether to enable the new connection.

8

In the Max. Connections text box, type the maximum number of concurrent connections to the
vCloud Director instance.

9

In the Connection timeout (ms) text box, type the timeout interval in milliseconds.

10 Click Next.
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11 Select the authentication method for managing user access on the vCloud Director instance.
Option

Description

Per User Session

Select this option if your vCloud Director is in an Active Directory domain. Make
sure that the user has the necessary permissions to perform the required
operations.
Caution Each user who logs in to Orchestrator creates a new session to the
vCloud Director instance. Multiple sessions can rapidly strain CPU, memory, and
bandwidth.

Shared Session

Select this option to allow Orchestrator to create only one connection to the
vCloud Director instance. Type the credentials of a user who is a vCloud Director
administrator.

Note If the authentication data comes from LDAP or Single Sign On, make sure the vCloud Director
organization is configured with the same LDAP or Single Sign On instance and the user is imported in
this organization.
12 Select whether to use SAML authentication and provide the needed details.
Option

Description

No

Provides basic authentication

Yes

Provides SAML authentication

13 In the Organization text box, type the name of the organization that users can access, and click
Submit.
n

Type System if you want administrators to be able to run User API, Admin API, and Admin
Extensions API operations in all organizations on the vCloud Director instance.

n

Type the name of a specific organization if you want administrators to be able to run only User
API and Admin API operations in the specified organization.

14 Repeat Step 4 through Step 13 for each vCloud Director instance.

Synchronize the Time by Using the vSphere Web Client
You must synchronize the time on the virtual machines on which the Orchestrator server, vCloud Director
server, and Single Sign On server are installed, to avoid possible errors such as the imported workflows
return an incorrect error message or the inventory does not get upgrated.
Procedure

1

Configure all your ESXi hosts to synchronize with the NTP server.
a

In the vSphere Web Client, select the ESXi host.

b

On the Manage tab, click Time Configuration, and click the Edit link.

c

Select Use Network Time Protocol (Enable NTP client).

d

From the NTP Service Startup Policy drop-down menu, select Start and stop with host.

VMware, Inc.
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2

e

In the NTP Servers text box, add all your NTP servers.

f

Click Start or Restart to update the NTP service settings.

g

Click OK.

Synchronize the time on all your virtual machines.
a

In the vSphere Web Client, right-click a virtual machine and select Edit Settings.

b

On the VM Options tab, click VMware Tools and select Synchronize guest time with host.

VMware, Inc.
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2

The vCloud Director plug-in workflow library contains workflows that allow you to manage vCloud Director
instances and run custom vCloud Director operations.
You can use the Inventory view in the Orchestrator client to manage the available vCloud Director
resources by running workflows on them.
This section includes the following topics:
n

Using the vCloud Director Plug-In Inventory

n

Access the vCloud Director Plug-In Workflow Library

n

Standard User Workflows

n

Admin Workflows

n

Admin Extension Workflows

Using the vCloud Director Plug-In Inventory
The vCloud Director plug-in exposes all objects in the connected vCloud Director instances in the
Inventory view. You can use the Inventory view to add authorization elements or to run workflows on
vCloud Director objects.
You can enable the Use contextual menu in inventory option to display the workflows that are available
for an inventory object. After the option is enabled, when you right-click an object in the Orchestrator
inventory, all available workflows for the object are displayed.

Disabling the Inventory Update
When you develop a complex workflow, you can disable the automatic update of the list of inventory
objects, to avoid performance issues.
The inventory is synchronized on each change in vCloud Director. When you develop complex workflows,
the frequent update of elements might cause a huge number of inventory change notifications and
performance issues. You can avoid performance issues by preventing redundant inventory updates.
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To disable the inventory update, you must call the
VclProfiler.enableInventoryNotifications(false) method. The
VclProfiler.enableInventoryNotifications() method is reference counted. To allow multiple
workflows to disable or enable inventory updates when needed, you should match each call to
enableInventoryNotifications(false) with enableInventoryNotifications(true). By default,
inventory updates are enabled. Disabling the inventory updates affects all users of the plug-in.

Access the vCloud Director Plug-In Workflow Library
You must use the Orchestrator client to access the elements from the vCloud Director plug-in workflow
library.
The vCloud Director plug-in workflow library contains building block workflows that allow you to run
automated processes related to the management of vCloud Director instances. The workflows are
grouped into categories depending on their functional area. You can integrate standard workflows from
the workflow library in custom workflows.
Procedure

1

Log in to the Orchestrator client as an administrator and select Design or Run from the drop-down
menu in the left upper corner.

2

Click the Workflows view in the Orchestrator client left pane.
Option

Action

Access the set of standard workflow
categories

In the hierarchical list, select Library > vCloud Director and expand the
selection.

Access the set of administrative
workflow categories

In the hierarchical list, select Library > vCloud Director > Admin and expand
the selection.

Access the set of administrative
extension workflow categories

In the hierarchical list, select Library > vCloud Director > Admin > Extension
and expand the selection.

Standard User Workflows
The vCloud Director workflow category contains standard workflows related to vCloud Director
management.

Catalog Item Workflows
The Catalog Item workflow category contains workflows related to catalog item management.
You can access these workflows from Library > vCloud Director > Catalog Item.
Workflow Name

Description

Add a catalog item

Adds a new item to a catalog. The new item can be a media file or a vApp template.

Delete a catalog item

Deletes a catalog item from a catalog.

Update a catalog item

Updates a catalog item.
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Disk Workflows
The Disk workflow category contains workflows related to disk management.
You can access these workflows from Library > vCloud Director > Disk.
Workflow Name

Description

Create a disk

Creates a new disk.

Delete a disk

Deletes a selected disk.

Update a disk

Updates a disk.

Media Workflows
The Media workflow category contains workflows related to media management.
You can access these workflows from Library > vCloud Director > Media.
Workflow Name

Description

Clone media

Clones a media file.

Delete media

Deletes a media file.

Update media

Updates a media file.

Upload media

Uploads a media file. The uploaded media can be an ISO file or a floppy file.

Plug-In Configuration Workflows
The Plug-in Configuration workflow category contains workflows related to vCloud Director connection
management.
You can access these workflows from Library > vCloud Director > Plug-in Configuration.
Workflow Name

Description

Add a connection

Adds a new vCloud Director connection to the plug-in configuration.

Delete a connection

Deletes a vCloud Director connection from the plug-in configuration.

Task Workflows
The Task workflow category contains workflows related to task management.
You can access these workflows from Library > vCloud Director > Task.
Workflow Name

Description

Wait for a task

Waits for a task to be completed.

VMware, Inc.
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vApp Workflows
The vApp workflow category contains workflows related to vApp management tasks such as cloning a
vApp, adding a vApp network, enabling maintenance mode for it, and so on.
You can access these workflows from Library > vCloud Director > vApp.
Workflow Name

Description

Add a vApp with a new virtual machine

Adds a new vApp containing a single virtual machine.

Add a vApp network

Add a new vApp network to a vApp.

Add a vApp template virtual machine

Adds a virtual machine to a vApp from a template.

Add a vApp virtual machine

Adds a virtual machine to a vApp.

Capture a vApp

Captures a vApp as a vApp template.

Clone a vApp

Clones a vApp.

Compose a vApp

Composes a vApp from vApp or virtual machine templates.

Delete a vApp

Deletes a vApp.

Delete a vApp network

Deletes a vApp network.

Download a vApp

Downloads a vApp to a local file system.

Enable maintenance mode

Enables or disables the maintenance mode for a vApp.

Rename a vApp

Renames a vApp.

Share a vApp

Updates the sharing configuration of a vApp.

Update a vApp

Updates a vApp.

vApp Custom Properties Workflows
The Custom Properties workflow category contains workflows related to vApp custom parameter
management.
You can access these workflows from Library > vCloud Director > vApp > Custom Properties.
Workflow Name

Description

Add a custom parameter

Adds a custom parameter to the vApp product section.

Modify a vApp custom parameter value

Modifies a vApp's custom parameter.

Remove a custom parameter from a vApp

Removes a custom parameter from a vApp.

Network Workflows
The Network workflow category contains workflows related to network configuration management.
You can access these workflows from Library > vCloud Director > vApp > Network > Config.
Workflow Name

Description

Add an organization vDC network to a vApp

Adds an organization vDC network to a vApp.
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Workflow Name

Description

Fence vApp networks

Sets the bridged network configuration to NAT-routed and disables the firewall
service.

You can access the DHCP workflow from Library > vCloud Director > vApp > Network > Config >
DHCP.
Workflow Name

Description

Set up a DHCP service

Sets up a DHCP service on a vApp network.

You can access the Firewall workflows from Library > vCloud Director > vApp > Network > Config >
Firewall.
Workflow Name

Description

Add a firewall rule

Adds a firewall rule to the firewall service on a vApp network.

Clear firewall rules

Clears all firewall rules of the firewall service on a vApp network.

Set up a firewall service

Sets up a firewall service on a vApp network.

You can access the NAT workflows from Library > vCloud Director > vApp > Network > Config > NAT.
Workflow Name

Description

Add a NAT rule

Adds a NAT rule to the NAT service on a vApp network.

Clear NAT rules

Clears all NAT rules of the NAT service on a vApp network.

Set up a NAT service

Sets up a NAT service on a vApp network.

You can access the Routing workflows from Library > vCloud Director > vApp > Network > Config >
Routing.
Workflow Name

Description

Add a static route

Adds a static route to the static routing service on a vApp network.

Clear static routes

Clears all static routes of a static routing service on a vApp network.

Set up a static routing service

Sets up a static routing service on a vApp network.

vApp Power Workflows
The Power workflow category contains workflows related to vApp power management.
You can access these workflows from Library > vCloud Director > vApp > Power.
Workflow Name

Description

Deploy a vApp

Deploys a vApp and optionally powers it on.

Discard a suspended state vApp

Discards the state of a suspended vApp.

Power off a vApp

Powers off a vApp. Does not free the resources reserved for the vApp.

Power on a vApp

Powers on a vApp.

Reboot a vApp

Sends a notification to the vApp's guest virtual machines to reboot.
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Workflow Name

Description

Reset a vApp

Resets a vApp.

Shut down a vApp

Sends a notification to the vApp's guest virtual machines to shut down.

Suspend a vApp

Suspends a vApp. Does not free the resources reserved for the vApp.

Undeploy a vApp

Stops or suspends a vApp and frees the resources reserved for the vApp.

vApp Snapshot Workflows
The Snapshot workflow category contains workflows related to vApp snapshot management.
You can access these workflows from Library > vCloud Director > vApp > Snapshot.
Workflow Name

Description

Create a snapshot

Creates a vApp snapshot.

Remove all snapshots

Removes all vApp snapshots.

Revert to current snapshot

Reverts to the current vApp snapshot.

VM Workflows
The VM workflow category contains workflows related to virtual machine management.
You can access these workflows from Library > vCloud Director > vApp > VM.
Workflow Name

Description

Delete a virtual machine

Deletes a virtual machine.

Eject media

Ejects media from a virtual machine.

Insert media

Inserts media into a virtual machine.

Rename a virtual machine

Renames a virtual machine.

Wire a virtual machine network

Connects a virtual machine's NIC with a vApp network and assigns IP properties to the NIC.

VM CPU Workflows
The CPU workflow category contains workflows related to virtual machine CPU management.
You can access the workflow from Library > vCloud Director > vApp > VM > CPU.
Workflow Name

Description

Change the number of CPUs

Changes the number of CPUs of a virtual machine.

VM Custom Properties Workflows
The Custom Properties workflow category contains workflows related to virtual machine custom
parameter management.
You can access these workflows from Library > vCloud Director > vApp > VM > Custom Properties.
Workflow Name

VMware, Inc.
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Workflow Name

Description

Add a custom parameter to a virtual machine

Adds a custom parameter to a vApp product section.

Modify the custom parameter value for a virtual machine

Modifies a virtual machine's custom parameter.

Remove a custom parameter from a virtual machine

Removes a custom parameter from a virtual machine.

VM Guest Customization Workflows
The Guest Customization workflow category contains workflows related to virtual machine guest
customization.
You can access these workflows from Library > vCloud Director > vApp > VM > Guest Customization.
Workflow Name

Description

Change computer name

Changes the computer name of a virtual machine.

Customize guest OS

Customizes the computer name and SID.

VM Hard Disk Workflows
The Hard Disk workflow category contains workflows related to virtual machine hard disk management.
You can access these workflows from Library > vCloud Director > vApp > VM > Hard Disk.
Workflow Name

Description

Add a hard disk

Adds a hard disk to a virtual machine.

Attach a hard disk

Attaches a hard disk to a virtual machine.

Change hard disk capacity

Changes a virtual machine's hard disk capacity.

Detach a hard disk

Detaches a hard disk from a virtual machine.

Remove a hard disk

Removes a hard disk from a virtual machine.

VM Memory Workflows
The Memory workflow category contains workflows related to virtual machine memory management.
You can access the workflow from Library > vCloud Director > vApp > VM > Memory.
Workflow Name

Description

Change memory capacity

Changes the memory capacity of a virtual machine.

VM NIC Workflows
The NIC workflow category contains workflows related to virtual machine NIC management.
You can access these workflows from Library > vCloud Director > vApp > VM > NIC.
Workflow Name

Description

Add a NIC

Add a NIC to a virtual machine.

Remove a NIC

Removes a NIC from a virtual machine.
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Workflow Name

Description

Update virtual machine MAC address

Changes the MAC address of a virtual machine.

Update virtual machine MAC and IP
addresses

Changes the NICs MAC addresses and updates the IP for network cards with a
pool allocation mode.

VM Power Workflows
The Power workflow category contains workflows related to virtual machine power management.
You can access these workflows from Library > vCloud Director > vApp > VM > Power.
Workflow Name

Description

Deploy a virtual machine

Deploys a virtual machine and optionally powers it on.

Discard a suspended state virtual machine

Discards the state of a suspended virtual machine.

Power off a virtual machine

Powers off a virtual machine. Does not free the resources reserved for the virtual
machine.

Power on a virtual machine

Powers on a virtual machine.

Reboot a virtual machine

Sends a notification to the virtual machine guest operating system to reboot.

Reset a virtual machine

Resets a virtual machine.

Shut down a virtual machine

Sends a notification to the virtual machine guest operating system to shut down.

Suspend a virtual machine

Suspends a virtual machine. Does not free the resources reserved for the virtual
machine.

Undeploy a virtual machine

Stops or suspends a virtual machine and frees the resources reserved for the virtual
machine.

VM Screen Workflows
The Screen workflow category contains workflows related to virtual machine screen management.
You can access these workflows from Library > vCloud Director > vApp > VM > Screen.
Workflow Name

Description

Acquire a ticket

Acquires a ticket for the remote console of a virtual machine.

Get a thumbnail

Gets a screenshot of a virtual machine's desktop.

VM Snapshot Workflows
The Snapshot workflow category contains workflows related to virtual machine snapshot management.
You can access these workflows from Library > vCloud Director > vApp > VM > Snapshot.
Workflow Name

Description

Create a snapshot

Creates a virtual machine snapshot.

Remove all snapshots

Removes all virtual machine snapshots.

Revert to current snapshot

Reverts to the current virtual machine snapshot.
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vApp Template Workflows
The vApp Template workflow category contains workflows related to vApp template management.
You can access these workflows from Library > vCloud Director > vApp Template.
Workflow Name

Description

Clone a vApp template

Clones a vApp template.

Delete a vApp template

Deletes a vApp template.

Download a vApp template

Downloads a vApp template as an OVF.

Instantiate a vApp template

Instantiates a vApp template as a vApp.

Update a vApp template

Updates a vApp template.

Upload a vApp template

Uploads an OVF as a vApp template.

Admin Workflows
The Admin workflow category contains workflows related to vCloud Director administrative management.

Catalog Workflows
The Catalog workflow category contains workflows related to catalog management.
You can access these workflows from Library > vCloud Director > Admin > Catalog.
Workflow Name

Description

Add a catalog

Adds a catalog to an organization.

Delete a catalog

Deletes a catalog.

Publish a catalog

Publishes or unpublishes a catalog to all organizations external to the catalog's organization.

Share a catalog

Updates the sharing configuration of a catalog.

Update a catalog

Updates a catalog.

Group Workflows
The Group workflow category contains workflows related to group management.
You can access these workflows from Library > vCloud Director > Admin > Group.
Workflow Name

Description

Delete a group

Deletes a group.

Import a group

Imports a group from the configured directory service to an organization.

Update a group

Updates a group.
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Organization Workflows
The Organization workflow category contains workflows related to organization management.
You can access these workflows from Library > vCloud Director > Admin > Organization.
Workflow Name

Description

Add an organization

Adds an organization to a vCloud Director instance.

Delete an organization

Deletes an organization.

Enable an organization

Enables an organization.

Update an organization

Updates an organization.

Role Workflows
The Role workflow category contains workflows related to role management.
You can access these workflows from Library > vCloud Director > Admin > Role.
Workflow Name

Description

Add a role

Adds a role to a vCloud Director instance.

Delete a role

Deletes a role.

Update a role

Updates a role.

User Workflows
The User workflow category contains workflows related to user management.
You can access these workflows from Library > vCloud Director > Admin > User.
Workflow Name

Description

Add a user

Adds a user to an organization or imports it from LDAP.

Delete a user

Deletes a user.

Enable a user

Enables or disables a user.

Update a user

Updates a user.

vDC Workflows
The vDC workflow category contains workflows related to virtual data center management.
You can access these workflows from Library > vCloud Director > Admin > vDC.
Workflow Name

Description

Add a vDC

Adds a vDC to an organization.

Delete a vDC

Deletes a vDC.
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Workflow Name

Description

Enable a vDC

Enables a vDC.

Update a vDC

Updates a vDC.

vCD Gateway Workflows
The Gateway workflow category contains workflows related to vDC gateway management.
You can access these workflows from Library > vCloud Director > Admin > vDC > Gateway.
Workflow Name

Description

Add a gateway

Adds a new gateway to a virtual datacenter.

Delete a gateway

Deletes a gateway from a virtual datacenter.

Update a gateway

Updates a gateway within a virtual datacenter.

Network Configuration Workflows
The Configuration workflow category contains workflows related to network configuration.
You can access the Gateway workflows from Library > vCloud Director > Admin > vDC > Gateway >
Config.
Workflow Name

Description

Add a gateway interface

Adds a new interface to a gateway.

You can access the DHCP workflows from Library > vCloud Director > Admin > vDC > Gateway >
Config > DHCP.
Workflow Name

Description

Add a DHCP pool

Adds a new DHCP pool to the DHCP service.

Enable a DHCP service

Enables or disables the DHCP service on a gateway.

Set up a DHCP service

Sets up a DHCP service on a gateway.

You can access the Firewall workflows from Library > vCloud Director > Admin > vDC > Gateway >
Config > Firewall.
Workflow Name

Description

Add a firewall rule

Adds a firewall rule to the firewall service on a gateway.

Clear firewall rules

Clears all firewall rules of the firewall service on a gateway.

Set up a firewall service

Sets up a firewall service on a gateway.

You can access the NAT workflows from Library > vCloud Director > Admin > vDC > Gateway >
Config > NAT.
Workflow Name

Description

Add a NAT rule

Adds a NAT rule to the NAT service on a gateway.
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Workflow Name

Description

Clear NAT rules

Clears all NAT rules of the NAT service on a gateway.

Enable a NAT service

Enables or disables a NAT service on a gateway.

Set up a NAT service

Sets up a NAT service on a gateway.

You can access the Routing workflows from Library > vCloud Director > Admin > vDC > Gateway >
Config > Routing.
Workflow Name

Description

Add a static route

Adds a static route to the static routing service on a gateway.

Clear static routes

Clears all static routes of a static routing service on a gateway.

Enable a static routing service

Enables or disables the routing service on a gateway.

Set up a static routing service

Sets up a static routing service on a gateway.

You can access the VPN workflows from Library > vCloud Director > Admin > vDC > Gateway >
Config > VPN.
Workflow Name

Description

Add a VPN endpoint

Adds a VPN endpoint to the VPN service on a gateway.

Add a VPN tunnel

Adds a VPN tunnel to the VPN service on a gateway.

Clear VPN tunnels

Clears all VPN tunnels of the VPN service on a gateway.

Set up a VPN service

Sets up a VPN service on a gateway.

vDC Network Workflows
The Network workflow category contains workflows related to organization network management.
You can access these workflows from Library > vCloud Director > Admin > vDC > Network.
Workflow Name

Description

Add an organization vDC network

Adds an organization vDC network to a virtual datacenter.

Delete an organization vDC network

Deletes a network within a virtual datacenter.

Update an organization vDC network

Updates a network within a virtual datacenter.

vDC Storage Profile Workflows
The Storage profile workflow category contains workflows related to storage profile management.
You can access these workflows from Library > vCloud Director > Admin > vDC > Storage Profile.
Workflow Name

Description

Add a storage profile

Adds a storage profile to a virtual datacenter.

Delete a storage profile

Deletes a storage profile from a virtual datacenter.

Update a storage profile

Updates a storage profile within a virtual datacenter.
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Admin Extension Workflows
The Extension workflow category contains workflows related to vCloud Director administrative extensions
management.

Licensing Reports Workflows
The Licensing Reports workflow category contains workflows related to licensing reports management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > Licensing
Reports.
Workflow Name

Description

Print licensing reports

Prints the licensing reports of a vCloud Director instance.

Notification Workflows
The Notifications workflow category contains workflows related to notification management.
You can access these workflows from Library > vCloud Director > Admin > Extensions >
Notifications.
Workflow Name

Description

Configure blocking tasks

Configures the blocking tasks settings of a vCloud Director instance.

Enable notifications

Enables or disables notifications from a vCloud Director instance.

Set up an AMQP broker

Configures the AMQP broker settings for a given vCloud Director instance.

VIM Server Workflows
The VIM Server workflow category contains workflows related to vCenter Server management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > VIM Server.
Workflow Name

Description

Import a virtual machine as a vApp

Imports a virtual machine from an available vCenter Server as a vApp.

Import a virtual machine as a vApp template

Imports a virtual machine from an available vCenter Server as a vApp template.

Import a virtual machine into a vApp

Imports a virtual machine from an available vCenter Server instance into an existing
vApp.

Reconnect to a vCenter Server instance

Tries to force a reconnection to a vCenter Server instance from its vCloud Director
host.

Register a vCenter Server instance

Registers a a vCenter Server instance to a vCloud Director instance.

Unregister a vCenter Server instance

Unregisters a vCenter Server instance.

Update a vCenter Server instance

Updates a vCenter Server instance.
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VMW Datastore Workflows
The VMW Datastore workflow category contains workflows related to datastore management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > VMW
Datastore.
Workflow Name

Description

Enable a datastore

Enables or disables a datastore.

VMW Host Workflows
The VMW Host workflow category contains workflows related to ESX host management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > VMW Host.
Workflow Name

Description

Enable an ESX host

Enables or disables an ESX host.

Prepare an ESX host

Prepares or unprepares an ESX host.

Repair an ESX host

Tries to repair an ESX host.

Upgrade an ESX host agent

Tries to upgrade an ESX host agent.

VMW Network Pool Workflows
The VMW Network Pool workflow category contains workflows related to etwork pool management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > VMW
Network Pool.
Workflow Name

Description

Add a network pool

Adds a network pool to a vCloud Director instance.

Delete a network pool

Deletes a network pool.

Update a network pool

Updates a network pool.

VMW Provider Network Workflows
The VMW Provider Network workflow category contains workflows related to provider network
management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > VMW
Provider Network.
Workflow Name

Description

Add an external network

Adds an external network to a vCloud Director instance.

Add an IP scope

Adds an IP scope to an external network.
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Workflow Name

Description

Delete an external network

Deletes an external network.

Update an external network

Updates an external network.

VMW Provider vDC Workflows
The VMW Provider vDC workflow category contains workflows related to provider vDC management.
You can access these workflows from Library > vCloud Director > Admin > Extensions > VMW
Provider vDC.
Workflow Name

Description

Add a provider vDC

Adds a provider vDC to a vCloud Director instance.

Add a resource pool to a provider vDC

Adds a resource pool to a provider vDC.

Delete a provider vDC

Deletes a provider vDC.

Enable a provider vDC

Enables or disables a provider vDC.

Enable a resource pool

Enables or disables a resource pool visible for a provider vDC.

Remove a resource pool from an ESX provider vDC

Removes a resource pool from a provider vDC.

Update a provider vDC

Updates a provider vDC.
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vCloud Director Plug-In
Scripting API

3

The vCloud Director plug-in scripting API contains classes, with their respective attributes and methods,
that allow interaction between vCenter Orchestrator and vCloud Director. The scripting API maps the
classes of the vCloud API to Orchestrator JavaScript classes that you can use to develop custom
Orchestrator workflows that interact with vCloud Director.
This section includes the following topics:
n

API Categories

n

Access the vCloud Director Plug-In API

n

Using Generic Queries

n

Using Non-Generic Queries

n

Decorator Objects

n

Scripting Examples

API Categories
The main categories of vCloud Director API classes are User API, Admin API, and Admin Extensions API.
With the User API, you can perform basic tasks. The Admin API adds administrative capabilities. With the
Admin Extensions API, you can manage components of the VMware virtual infrastructure.
The mapping of the vCloud Director 5.5 plug-in API classes corresponds to the vCloud SDK for Java 5.5
class mapping. For reference about classes and categories, see
http://communities.vmware.com/community/vmtn/developer/forums/vcloudsdkjava.

User API
User API classes are typically readable by all users, and can be modified by users with appropriate rights.
With the User API, you can examine organizations and virtual datacenters (vDCs). You can create vApps
in the organizations and in vDCs, and manage the created vApps. You can control vApp networks and
create vApp templates and media files, such as ISO and floppy images. You can store vApp templates
and media files in catalogs for easy access and sharing between organizations and vDCs.
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Admin API
Admin API classes are typically readable by all users, but can be created and modified only by a system
administrator, organization administrator, or another user who has administrative rights.
With the Admin API, you can administrate and create organizations, vDCs, organization networks, and
authorization entities, such as roles, rights, users, and groups. You can create, delete, and modify a
catalog of templates and media files.

Admin Extensions API
Admin Extensions API classes can be created and modified only by a system administrator.
The Admin Extensions API is specific to VMware. With the Admin Extensions API, you can manage
entities such as provider vDCs, network pools, and vCenter Server instances.

Access the vCloud Director Plug-In API
Orchestrator provides an API Explorer to allow you to search the vCloud Director plug-in API and see the
documentation for JavaScript objects that you can use in scripted elements.
Procedure

1

Log in to the Orchestrator client and select Design or Run from the drop-down menu in the left upper
corner.

2

Select Tools > API Explorer.

3

To expand the hierarchical list of vCloud Director plug-in API objects, double-click the vCloud module
in the left pane.

What to do next

You can copy code from API elements and paste it into scripting boxes. For more information about API
scripting, see Developing with VMware vCenter Orchestrator.

Using Generic Queries
When you use generic queries, such as QueryService.queryRecords and
QueryService.queryIdRecords, you must use specific query types and field types to get the
appropriate result record types.
The following table lists the expected query types, field types, and record result types when working with
generic queries.
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VclQueryRecordType Value and
Query Fields Enumeration Type

Query Result Record Type

ADMINALLOCATEDEXTERNALADDRESS

VclQueryResultAdminAllocatedExternalAddressRecord

VclQueryAdminAllocatedExternalAddressField
ADMINCATALOG

VclQueryResultAdminCatalogRecord

VclQueryAdminCatalogField
ADMINCATALOGITEM

VclQueryResultAdminCatalogItemRecord

VclQueryAdminCatalogItemField
ADMINGROUP

VclQueryResultAdminGroupRecord

VclQueryAdminGroupField
ADMINMEDIA

VclQueryResultAdminMediaRecord

VclQueryAdminMediaField
ADMINORGNETWORK

VclQueryResultAdminOrgNetworkRecord

VclQueryAdminOrgNetworkField
ADMINORGVDC

VclQueryResultAdminVdcRecord

VclQueryAdminVdcField
ADMINSHADOWVM

VclQueryResultAdminShadowVMRecord

VclQueryAdminShadowVMField
ADMINTASK

VclQueryResultAdminTaskRecord

VclQueryAdminTaskField
ADMINUSER

VclQueryResultAdminUserRecord

VclQueryAdminUserField
ADMINVAPP

VclQueryResultAdminVAppRecord

VclQueryAdminVAppField
ADMINVAPPNETWORK

VclQueryResultAdminVAppNetworkRecord

VclQueryAdminVAppNetworkField
ADMINVAPPTEMPLATE

VclQueryResultAdminVAppTemplateRecord

VclQueryAdminVAppTemplateField
ADMINVM

VclQueryResultAdminVMRecord

VclQueryAdminVMField
ALLOCATEDEXTERNALADDRESS

VclQueryResultAllocatedExternalAddressRecord

VclQueryAllocatedExternalAddressField
BLOCKINGTASK

VclQueryResultBlockingTaskRecord

VclQueryBlockingTaskField
CATALOG

VclQueryResultCatalogRecord

VclQueryCatalogField
CATALOGITEM

VclQueryResultCatalogItemRecord

VclQueryCatalogItemField
CELL

VclQueryResultCellRecord

VclQueryCellField
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VclQueryRecordType Value and
Query Fields Enumeration Type

Query Result Record Type

DATASTORE

VclQueryResultDatastoreRecord

VclQueryDatastoreField
DATSTOREPROVIDERVDCRELATION

VclQueryResultDatastoreProviderVdcRelationRecord

VclQueryDatastoreProviderVdcRelationField
DVSWITCH

VclQueryResultDvSwitchRecord

VclQueryDvSwitchField
EVENT

VclQueryResultEventRecord

VclQueryEventField
EXTERNALNETWORK

VclQueryResultNetworkRecord

VclQueryNetworkField
GROUP

VclQueryResultGroupRecord

VclQueryGroupField
HOST

VclQueryResultHostRecord

VclQueryHostField
MEDIA

VclQueryResultMediaRecord

VclQueryMediaField
NETWORKPOOL

VclQueryResultNetworkPoolRecord

VclQueryNetworkPoolField
ORGANIZATION

VclQueryResultOrgRecord

VclQueryOrgField
ORGNETWORK

VclQueryResultOrgNetworkRecord

VclQueryOrgNetworkField
ORGVDC

VclQueryResultOrgVdcRecord

VclQueryOrgVdcField
ORGVDCRESOURCEPOOLRELATION

VclQueryResultOrgVdcResourcePoolRelationRecord

VclQueryOrgVdcResourcePoolRelationField
PORTGROUP

VclQueryResultPortgroupRecord

VclQueryPortgroupField
PROVIDERVDC

VclQueryResultVMWProviderVdcRecord

VclQueryVMWProviderVdcField
PROVIDERVDCRESOURCEPOOLRELATION

VclQueryResultProviderVdcResourcePoolRelationRecord

VclQueryProviderVdcResourcePoolRelationField
RESOURCEPOOL

VclQueryResultResourcePoolRecord

VclQueryResourcePoolField
RIGHT

VclQueryResultRightRecord

VclQueryRightField
ROLE

VclQueryResultRoleRecord

VclQueryRoleField
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VclQueryRecordType Value and
Query Fields Enumeration Type

Query Result Record Type

STRANDEDUSER

VclQueryResultStrandedUserRecord

VclQueryStrandedUserField
TASK

VclQueryResultTaskRecord

VclQueryTaskField
USER

VclQueryResultUserRecord

VclQueryUserField
VAPP

VclQueryResultVAppRecord

VclQueryVAppField
VAPPNETWORK

VclQueryResultVAppNetworkRecord

VclQueryVAppNetworkField
VAPPORGNETWORKRELATION

VclQueryResultVAppOrgNetworkRelationRecord

VclQueryVAppOrgNetworkRelationField
VAPPTEMPLATE

VclQueryResultVAppTemplateRecord

VclQueryVAppTemplateField
VIRTUALCENTER

VclQueryResultVirtualCenterRecord

VclQueryVirtualCenterField
VM

VclQueryResultVMRecord

VclQueryVMField

Using Non-Generic Queries
When you use non-generic queries, the name of the query method determines the result record type.

Example: Records Returned by Non-Generic Queries
The following are examples of records returned by non-generic queries.
n

queryVmRecords returns records of type VclQueryResultVMRecord.

n

queryvAppRecords returns records of type VclQueryResultVAppRecord.

Example: Enumeration Types for Query Filter Creation
The following are examples of enumeration types that should be used when creating a query filter.
n

queryVmRecords accepts fields of type VclQueryVMField.

n

queryvAppRecords accepts fields of type VclQueryVAppField.
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Decorator Objects
Decorator objects hide the complexity of the vCloud Director REST API.
Decorators provide an easy-to-use interface to the vCloud Director REST API when working with data
collections and data objects. Decorators manipulate live object or collection instances. For example,
every modification of a collection affects the container object.

VclAbstractRecordResultSet Decorator
The VclAbstractRecordResultSet decorator object makes the manipulation of generic query record
results easier. This decorator provides methods for getting records of the expected type, as well as
navigating between record result pages.

VclRecordResultSet Decorator
The VclRecordResultSet decorator object makes the manipulation of specific query record results
easier. This decorator provides methods for getting records of a predefined type, as well as navigating
between record result pages.

VclReferenceResultSet Decorator
The VclReferenceResultSet decorator object makes the manipulation of generic or specific query
reference results easier. This decorator provides methods for getting object references, as well as
navigating between reference result pages.

Scripting Examples
You can cut, paste, and adapt the JavaScript examples to help you write scripts for common
vCloud Director tasks.
For more information about scripting, see the vCenter Orchestrator Developer's Guide.

Example: Get Records for All Enabled Organizations
The following JavaScript example uses the AdminQueryService object to get records for all enabled
organizations on a given vCloud Director instance.
var host = ...
var queryService = host.toAdminObject().getAdminQueryService();
var expression = new VclExpression(VclQueryOrgField.ISENABLED, "true", VclExpressionType.EQUALS);
var filter = new VclFilter(expression);
var params = new VclQueryParams();
params.setFilter(filter);
var resultSet = queryService.queryOrgRecords(params);
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while (resultSet != null) {
// the records should be of type related to the query
// in this case the type is VclQueryResultOrgRecord
var records = resultSet.getRecords();
System.log(records.length + " records found");
for (var i = 0; i < records.length; i++) {
System.log(records[i].name);
}
if (resultSet.hasNextPage()) {
resultSet = resultSet.getNextPage();
} else {
break;
}
}

Example: Get References to All Enabled Organizations
The following JavaScript example uses the AdminQueryService object to get references to all enabled
organizations on a given vCloud Director instance.
var host = ...
var queryService = host.toAdminObject().getAdminQueryService();
var expression = new VclExpression(VclQueryOrgField.ISENABLED, "true", VclExpressionType.EQUALS);
var filter = new VclFilter(expression);
var params = new VclQueryParams();
params.setFilter(filter);
var resultSet = queryService.queryOrgReferences(params);
while (resultSet != null) {
// the type of the references is predefined - VclReference
var references = resultSet.getReferences();
System.log(references .length + " references found");
for (i = 0; i < references.length; i++) {
System.log(references[i].href);
}
if (resultSet.hasNextPage()) {
resultSet = resultSet.getNextPage();
} else {
break;
}
}

Example: Get Records for All Virtual Machines Inside a vApp
The following JavaScript example uses the QueryService object to get records for all virtual machines
inside a vApp.
var vapp = ...
var queryService = vapp.getHost().getQueryService();
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var expression = new VclExpression(VclQueryVMField.CONTAINER, vapp.getReference().href,
VclExpressionType.EQUALS);
var filter = new VclFilter(expression);
var params = new VclQueryParams();
params.setFilter(filter);
var resultSet = queryService.queryRecords(VclQueryRecordType.ADMINVM, params);
while (resultSet != null) {
var records = resultSet.getRecords(new VclQueryResultAdminVMRecord());
System.log(records.length + " records found");
for (i = 0; i < records.length; i++) {
System.log(records[i].name);
}
if (resultSet.hasNextPage()) {
resultSet = resultSet.getNextPage();
} else {
break;
}
}

Example: Resume a Blocking Task Related to a vApp Deployment
Notification
With the following JavaScript example, you can resume a blocking task related to a vApp deployment
notification.
var host = ...
var message = ...
var helper = new VclNotificationHelper();
helper.setMessage(message);
if (helper.getNotificationEventType() == VclEventType.VAPP_DEPLOY) {
var vappLink = helper.getEntityLink();
var vapp = host.getEntityById(vappLink.type, vappLink.id);
// do something with the vApp ...
if (helper.isBlockingTask()) {
var taskLink = helper.getBlockingTaskLink();
var task = host.getEntityById(taskLink.type, taskLink.id);
task.resume("put the resuming message here");
}
}

Example: Configure a DHCP Service on a vApp Network
With the following JavaScript example, you can configure a DHCP service on a vApp network.
var
var
var
var

dhcpService = ...
vapp = ...
networkName = ...
networkConfigSection = vapp.getNetworkConfigSection();
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var found = false;
var existingNetworkConfigArray = networkConfigSection.networkConfig.enumerate();
for (index = 0; index < existingNetworkConfigArray.length; index++) {
var networkConfig = existingNetworkConfigArray[index];
if (networkConfig.networkName == networkName) {
var networkConfiguration = networkConfig.configuration;
if (networkConfiguration.fenceMode == VclFenceModeValuesType.BRIDGED.value) {
throw 'Dhcp service cannot be applied to network "' + networkName + '"!';
}
if (networkConfiguration.features == null) {
networkConfiguration.features = new VclNetworkFeatures();
}
var serviceSet = networkConfiguration.features.networkService;
var services = serviceSet.find(new VclDhcpService());
if (services.length > 0) {
for (i = 0; i < services.length; i++) {
serviceSet.remove(services[i]);
}
}
serviceSet.add(dhcpService);
found = true;
}
}
if (!found) {
throw 'Network "' + networkName + '" does not exist!';
}
task = vapp.updateSection(networkConfigSection);

Example: Configure a DHCP Service on a Gateway
With the following JavaScript example, you can configure a DHCP service on a gateway.
var gatewayDhcpService = ...
var gateway = ....
var gatewayConfiguration = gateway.configuration;
if (gatewayConfiguration.edgeGatewayServiceConfiguration == null) {
gatewayConfiguration.edgeGatewayServiceConfiguration = new VclGatewayFeatures();
}
var serviceSet = gatewayConfiguration.edgeGatewayServiceConfiguration.networkService;
var services = serviceSet.find(new VclGatewayDhcpService());
if (services.length > 0) {
for (i = 0; i < services.length; i++) {
serviceSet.remove(services[i]);
}
}
serviceSet.add(gatewayDhcpService);
task = gateway.update();
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Example: Add a VPN Endpoint
With the following JavaScript example, you can add a VPN endpoint to a gateway.
var vpnEndpoint = ...
var gateway = ...
var gatewayConfiguration = gateway.configuration;
if (gatewayConfiguration.edgeGatewayServiceConfiguration == null) {
gatewayConfiguration.edgeGatewayServiceConfiguration = new
VclGatewayFeatures();
}
var serviceSet = gatewayConfiguration.edgeGatewayServiceConfiguration.networkService;
var services = serviceSet.find(new VclGatewayIpsecVpnService());
if (services.length == 0) {
throw 'VPN service not found on gateway ' + gateway.name;
}
services[0].endpoint.add(vpnEndpoint);
gateway.configuration = gatewayConfiguration;
task = gateway.update();

Example: Obtain Performance Statistics
With the following JavaScript example, you can obtain performance statistics for the vCloud Director plugin.
VclProfiler.enableInstanceCounters(true);
...
var instances = VclProfiler.getInstanceCount("VclReference");
System.log("references: " + instances);
...
VclProfiler.enableInstanceCounters(false);
...
var host = ...
var cacheHitCount = VclProfiler.getCacheHitCount(host);
System.log("cache hits: " + cacheHitCount);
var cacheMissCount = VclProfiler.getCacheMissCount(host);
System.log("cache misses: " + cacheMissCount);
var cacheObjCount = VclProfiler.getCacheObjectCount(host);
System.log("cache objects: " + cacheObjCount);
...
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Example: Get the Plug-In Version
With the following JavaScript example, you can get the plug-in version and distinguish future plug-in
versions.
var version = VclHostManager.getVersion();
if (version == "5.5") {
System.log("Plug-in 5.5 is installed!");
}

Example: Get Entity Instance Count
With the following JavaScript example, you can get any class instance count.
VclProfiler.enableInstanceCounters(true);
...
var className = VclProfiler.getClassNameByFinderType(VclFinderType.HOST);
System.log(VclProfiler.getInstanceCount(className));
...
VclProfiler.enableInstanceCounters(false);
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